Reviewer’s Guide

Frame Capture Analysis Tool
FCAT
# TABLE OF CONTENTS

**Introducing FCAT** .................................................................................................................. 4
  - The Measurement of Game Frames ....................................................................................... 4
  - What is included with FCAT ............................................................................................... 4
**Capturing Displayed Frames** .............................................................................................. 5
  - The DataPath VisionDVI-DL Capture Card ........................................................................... 5
  - GPUs & Displays Run at Different Rates ............................................................................. 6
**Dropped & Runt Frames** ....................................................................................................... 7
  - Dropped Frames ................................................................................................................. 9
  - Runt Frames ..................................................................................................................... 9

**The Systems | Two are Needed** ........................................................................................... 11
  - The Gaming System .......................................................................................................... 11
  - The Capture System ......................................................................................................... 11
    - Chipset & CPU ............................................................................................................... 11
    - SSD RAID Array ............................................................................................................ 11
    - Regarding SSD RAID Arrays ......................................................................................... 11
  - The DVI Splitter ............................................................................................................... 12
    - Gefen DVI DL Splitter ................................................................................................... 12
    - NVIDIA Clone Mode ..................................................................................................... 13
  - Installing the VisionDVI-DL Capture Card ........................................................................ 13
    - Installing the Vision Driver .......................................................................................... 13
    - Installing the Vision Software ...................................................................................... 14
    - Vision Configure ........................................................................................................... 14
    - Vision Window .............................................................................................................. 16
  - Supported Resolutions .................................................................................................... 16

**Overlay | Color Bars for Games** ............................................................................................ 17
  - Running Overlay ............................................................................................................. 17
  - Overlay & Fraps ................................................................................................................ 18

**Capturing Game Playback & Benchmarks** ......................................................................... 19
  - Use VirtualDub ................................................................................................................. 19
  - Configuring VirtualDub ................................................................................................... 19
General Settings.................................................................................................................................19
Capture AVI Settings ............................................................................................................................20
Resolution Settings ...............................................................................................................................21
Capturing Video .....................................................................................................................................22
Video Playback & Testing .......................................................................................................................24
**Extractor | Post Video processing** ........................................................................................................26
Extractor Analysis Tool ..........................................................................................................................26
Load Video File .......................................................................................................................................27
Postprocessing ........................................................................................................................................27
Column to Analyze .................................................................................................................................27
**FCAT Scripts | Creating Tables & Charts** .............................................................................................28
Strawberry Perl and GNU Plot ................................................................................................................28
Using the FCAT Scripts ..........................................................................................................................28
  STEP 1 | Unpack the FCAT Tools ...........................................................................................................29
  STEP 2 | FCAT Directory Structure .......................................................................................................29
  STEP 4 | run_doall.bat ............................................................................................................................29
Customizing the Data .............................................................................................................................30
  STEP 3 | Captures ....................................................................................................................................29
  STEP 4 | Run the run_doall.bat files .......................................................................................................31
  STEP 5 | Run the run_fcat.bat file. ............................................................................................................32
Using the FCAT Data .............................................................................................................................33
  The PIVOT Table ..................................................................................................................................37
**NVIDIA Contact Information** .............................................................................................................42
NVIDIA North/Latin America Public Relations ......................................................................................42
INTRODUCING FCAT

*FCAT stands for Frame Capture Analysis Tool*

FCAT allows for the analysis of individual frames captured from single- and multi-GPU configurations.

NVIDIA has been developing and using FCAT internally over the last two years to analyze and improve the single card and SLI experience that we deliver to our GeForce GTX customers. We have made this tool available to help press and editors to fully understand how game frames are processed and delivered, especially in multi-GPU configurations. FCAT is freely modifiable and redistributable, and we expect third-parties to replicate and ultimately replace FCAT tools with their own.

The Measurement of Game Frames

*The goal of FCAT is to analyze the way frames are seen by gamers*

Currently, software is used to measure the game frames that the GPU delivers. This is typically characterized as frames per second (FPS). However, software-only methods have problems because they only measure the frames that the game engine generates. Software cannot measure the frames that are actually delivered to the display, which affects the overall gaming experience.

FCAT is a method for measuring actual frames that have been delivered to the display; the frames that you actually see. FCAT works in concert with a high-speed capture card to capture a color overlay that is painted on every frame that is drawn to the display. Included are tools that take the color bar information, measure the size of them, and determine if any of the color bars are missing. Perl scripts are then used to analyze that data, and turn the data into graphs and charts.

What is included with FCAT

- **Overlay**
  - DXFrameOverlay.dll + Enable Overlay.exe
    - Overlays a fixed color sequence over the game while it’s running

- **Extractor**
  - Extractor.exe
    - Output = CSV of overlay colors and scanlines

- **Analysis Tools**
  - run_doall.bat
    - run_nv.bat
    - run_amd.bat
    - These are batch files that expedite the use of the PERL script files below.
  - fcat.pl
    - PERL script that combines bars and identifies runts and drops
Output = CSV of HW frametimes (similar to Fraps), and CSV of Original FPS, New FPS, Runts, drops

- **gen_percentiles.pl**
  PERL script that generates the 95 and 99th frametime percentile calculations.

- **pivot.pl**
  PERL script that generates a summary CSV file (good for a pivot table).

- **doall.pl**
  PERL helper script to generate a big batch file.

### Capturing Displayed Frames

Capturing displayed frames is very difficult. If you control the driver, it can be done with software. But drivers can be written to hide effects like dropped and runt frames. What is required is a method that measures the actual output from the DVI connector before it’s delivered to the monitor.

We have found that placing a high-speed capture card in a special “capture system” that captures the game system’s DVI port output can be used to accurately measure frames. If the captured data is saved as a movie, and overlay software is used to draw color bars on the left-hand side of every frame, you then have some useful data. All that’s needed at this point is a software extractor that looks at the captured video data and see problems based on the expected color bar sequence and individual color bar length (to be described in more detail below).

We have written this overlay software, and we have created the extractor that simply generates an Excel file off the bar lengths. Simple Perl software is then used to process the bar-length data across all of your GPUs and all of your games, with the result being some very interesting graphs.

### The DataPath VisionDVI-DL Capture Card

The DataPath Limited VisionDVI-DL capture card is used to capture frames from the gaming system. This is done at full resolution at 60 frames per second to match the 60Hz speed of typical displays.

A tremendous amount of data is generated, and high-speed storage is required to keep up with the high 650MB/sec data rates, especially when capturing at resolutions of 2560x1440.
GPUs & Displays Run at Different Rates

The truth is that GPUs and displays actually run at different rates.

Figure 1: Frames are rendered as fast as the GPU can make them, and are sent to the display where they are shown at a fixed frequency.

GPUs run as fast as they can to produce frames. When GPUs produce frames at 90, 43, 20, or even 12 frames per second, it does this independently of the refresh rate of the display; because GPUs process frames of varying graphics complexity, running at different frequencies depending on load. Displays, on the other hand, run at a fixed rate. Displays refresh every 16ms, which is 60Hz, and this rate never changes. Clearly, there can be a rate synchronization problem here.

Figure 2: GPUs and displays run at different rates. A capture card called the DataPath VisionDVI-DL is used to grab the actual displayed image from the game system, matching the actual image timing.
Software tools, like Fraps, actually capture frames from the frame buffer off the GPU. However, this data is not what you see: it is not representative of everything that is seen on the display. There is actually a process called scan out, and that is the difference. What FCAT is measuring is what is happening right at the display, as opposed to what is in the frame buffer.

Fraps actually captures calls that occur between the game and DirectX, before graphics commands and data are actually sent to the GPU for rendering. The area that Fraps measures contains graphics abstraction layers, the mappings of DirectX calls to the GPU hardware that is actually doing the display rendering and display. All of these operations can take a variable amount of time per frame based on scene complexity, with frames generated quickly or slowly by the GPU, and all of it can affect what is happening on the display. This is why measuring what is actually drawn to the display can provide very different results than measuring the input to the GPU rendering pipeline.

**Dropped & Runt Frames**

For smooth game animation to work perfectly, the game frames should be displayed at an even rate, and each frame should be of equal size to the frame that came before it. Such exact frame-to-frame timing rarely happens in reality.
Leading up to the creation of FCAT, we concluded that software-only based methods for frametime measurements miss key effects. Since software such as Fraps only measures frames that are transferred from the game to DirectX—instead of the frames that are actually processed by the GPU and shown on the display, it misses two very important effects – dropped frames and runt frames.

Figure 5: Fully formed frames. You can see that the color bars correctly follow each other: Purple, Olive, Gray, and then Fuchsia.
If every frame were given one of sixteen consecutive colors, they should each display a color in order without any of those color-sequenced frames missing (denoting a dropped frame), and without any of those color bars being too short (denoting a runt frame). This is why we developed as part of FCAT, an overlay tool where color coded bars are mapped to each frame and then measured.

**Dropped Frames**

A drop frame occurs when the game rendered a frame, but something went wrong, and that frame never actually got drawn on the screen. Or the graphics hardware and driver may purposefully drop frames because they can’t keep up with game timing. Fraps would never know that the frame was dropped in the graphics pipeline and never seen. Fraps says the game sent the frame, so it must be great, even though the frame was never completely rendered and displayed. As such, Fraps counts them as fully rendered and displayed frames, artificially and incorrectly inflating the overall FPS score.

![Dropped Frame](image)

*Figure 6:* A dropped frame. Frame 2 was never displayed; it should have been an Olive frame in-between the Purple and Gray frames.

**Runt Frames**

Runt frames occur when one of the graphics chips in a multi-GPU configuration draws a frame that is only displayed for 1-4 milliseconds. This makes the runt frame a very, very short frame. In fact, it’s so short, it cannot be perceived by the human eye.

By default, runt frames are frames that are 20 scan lines or less. On a typical 1920x1080 display, a runt is 1 to 20 of those 1080 vertical lines of screen data. So small, it cannot be seen from a perpetual perspective. And, these runts become smaller when even larger displays with 1440 and 1600 vertical scan lines are used. However, these runt frames are counted as fully rendered and displayed frames by
Fraps. In some cases, the performance difference between what users see and Fraps reports is quite large.

![Game Frames](image)

**Figure 7:** A runt frame. The Olive frame is a sliver of color in-between the Purple and Gray color frames.

If a runt were shown with color bars as in the chart above, it would be barely noticeable; just a line of color in-between two long bars.

Typically, a large tear in screen display occurs with the runt, but again, since the frame is displayed for such a short period of time, the human eye does not see the tear, but it’s there as the image to the right clearly shows.
THE SYSTEMS | TWO ARE NEEDED

Two systems are required: a gaming system and a capture system.

The Gaming System

Any system can be used to play the games. If you have existing game/benchmark systems, then we recommend using those. Games can be captured from single or multiple GPU configurations.

The Capture System

The capture system is the system that has the VisionDVI-DL capture card in it. We have found that seating the VisionDVI-DL capture card in a x16 slot works best.

Chipset & CPU

The capture system can be any type of configuration. An Ivybridge CPU with Z77 is the recommended configuration. The CPU speed is not important, and running an overclocked capture system is not necessary nor recommended (for stability reasons).

NOTE: The VisionDVI-DL capture card seems to have resource issues when used with an Intel X79 motherboard. Ensure the latest firmware is used. Hardware features such as USB3, secondary Ethernet, etc. may need to be disabled in the system BIOS before the capture card will work properly. This was not experienced with non-Intel X79 motherboards.

SSD RAID Array

It is recommended that an SSD RAID be set up for capturing. A tremendous amount of I/O bandwidth is required (upwards of 650MB/sec) when capturing at 60FPS at the highest resolutions such as 5760x1440. For this reason, a storage array with sufficient bandwidth is needed.

Recommended storage solutions:

1. 3-4 SSD hard drives configured in a RAID 0 striped array.
2. A Thunderbolt motherboard and enclosure. The Promise Pegasus r4 Thunderbolt enclosure works well when used with four SSDs.
3. PCIe storage drives from OCZ and Intel.

Regarding SSD RAID Arrays

Do not install the Windows OS onto the RAID array. Install it on a separate single SSD so that Windows writes do not interfere with captures, leading to unwanted inserted/dropped frames.
Make sure that all four SSD drives used in the RAID array are connected to the Intel SATA connectors on the motherboard. Do not use third-party SATA controllers such as ASMEDIA, as they have been shown to induce inserted frames in captures. However, the ASMEDIA SATA connectors can be used for the Windows SSD (freeing up the Intel SATA connectors for RAID array).

**The DVI Splitter**

A DVI splitter is required to capture from non-NVIDIA configurations that use more than one GPU. NVIDIA allows for the cloning of screens across two DVI connectors in SLI mode, whereas CrossFire does not.

**Gefen DVI DL Splitter**

The DVI splitter contains three DVI ports; the input port, and two output ports labeled A and B.

The Gefen DVI DL Splitter allows a computer with a Dual Link DVI output to be connected to two or more Dual Link DVI displays at the same time. The DVI DL Splitter is connected with a Dual Link DVI cable from the gaming computer to the DVI DL Splitter input. There are two DVI outputs. DVI output 1 is the primary connection and is connected to the gaming display, and DVI output 2 is connected to the VisionDVI-DL capture card.

![Diagram of Gefen DVI DL Splitter connection](image)

**Figure 8:** DVI DL Splitter connection diagram

Connect three dual-link DVI cables as follows:

1. Connect DVI In port to the main GPU DVI connector on the gaming system.
2. Connect DVI output 1 to the DVI connector on the display connected to the gaming system.
3. Connect DVI output 2 to the Vision capture card DVI connector in the capture system.
4. Also make sure that the GPU DVI connector on the capture system is connected to the display on the capture system.

**NVIDIA Clone Mode**

NVIDIA allows for the cloning of screens across two DVI connectors in SLI mode, whereas AMD CrossFire does not. This means a DVI splitter is not required for capturing NVIDIA single- and multi-GPU configurations.

Refer to the SLI Multi-Monitor Configuration Tool at GeForce.com to determine how to connect the displays from the gaming and capture systems:

http://www.geforce.com/hardware/technology/sli/system-requirements

And then follow the instructions below in the NVIDIA Control Panel for enabling clone mode:

**Step 1:** Open NVIDIA Control Panel, and then select **Set up multiple displays**. Make sure both displays are selected.

**Step 2:** Right-click on displays and select **Clone with**.

**Step 3:** Done.

**Installing the VisionDVI-DL Capture Card**

There are two separate downloads for the VisionDVI-DL capture card: the driver install and the software install.

http://www.datapath.co.uk/products/video-capture-cards/visiondvi-dl

**Installing the Vision Driver**

Here is a direct link for the Vision driver:

http://www.datapath.co.uk/images/stories/filedownloader/imgdriverinstall.zip
The driver can be downloaded from the DataPath website (http://www.datapath.co.uk).

**Note: The DataPath Vision driver must be installed with Windows in Safe Mode.**

![Windows Drivers Install](image)

**Figure 9:** Attempting to install the driver in Windows will result in this error message.

Once the driver is installed, reboot into Windows to continue the installation process. Typically, a few Windows runtime files will need to be installed when Windows loads. Also, the firmware on the capture card may need to be updated as well. Allow the update process to finish, and then shut down and re-power the system as specified.

**Installing the Vision Software**

Here is the direct link for the Vision software:

http://www.datapath.co.uk/images/stories/filedownloader/vision_setup.exe

The Vision software does not require Safe Mode for installation. During the installation process, a number of settings are available. Click through the screens keeping the default values.

![Vision Configure](image)

![Vision window](image)

The software will create a Vision folder in Program Files. Inside are two important applications: Vision Configure and Vision Windows.

**Vision Configure**

Vision Configure is used to set the resolution and EDID values of the monitor that you are capturing from.
Figure 10: Click the Configure button to open the timings settings.

Figure 11: Make sure refresh settings match the resolution to be used on the gaming system. Make sure the Vertical Refresh is set to 60Hz.

Figure 12: A second Additional Timing tab is available to add other resolutions. Make sure the Vertical Refresh is set to 60Hz.
After using the Configure button to access/change the additional timings, you will need to reboot the target machine for the new EDID to take effect.

**Vision Window**

Make sure capture is working by pulling up the Vision window (listed in your program tabs under Vision). You should see a version of the game PC display. Make sure you close it before opening and capturing video using VirtualDub software (VirtualDub is described below).

![Vision Window](image)

**Figure 13:** The Vision Window allows you to quickly check if the video capture settings are working with the VisionDVI-DL capture card.

**Supported Resolutions**

The Vision capture card only appears to have the internal bandwidth to support resolutions of 1920x1080, 1920x1200, and 2560x1440. Unfortunately, larger resolutions including 5760x1600 and 7680x1600 require more bandwidth than the VisionDVI-DL capture card can handle.

NVIDIA Surround and AMD Eyefinity resolutions of 5760x1080 can be captured by hooking DVI Port A of the DVI splitter to the GPU DVI connector that drives the far left monitor of the Surround or Eyefinity array. You will essentially be capturing just the output of the 1920x1080 monitor that contains the Overlay bars. If this is done, ensure that the Vision Config and VirtualDub applications are properly configured for a 1920x1080 resolution.
The Overlay is a tool that runs on the game system. It generates the color bars that correspond with the game frames generated by the GPU and/or GPUs. Every frame is assigned a different color bar. The colors of these bars and the order of how they are displayed are important, as this information ultimately determines the accuracy of the game frames being generated and shown on the screen.

A total of sixteen color bars are generated. These sixteen colors are then reused. If a specific color is not seen in the expected location of the sequence, then that frame can be considered dropped. If the color bar is too short, then that frame could be a runt frame. The visual experience between a runt and a drop is about the same; it is super small to imperceptible. If you show movies with runts, what is delivered is an experience as if those frames were never rendered.

Running Overlay

When launched, the overlay opens a window on the desktop, but it actually runs in the background. This window can be minimized and placed out of the way on the desktop.
Overlay & Fraps
The Overlay may not always work with Fraps running in the background. If you would like Fraps data to run on the screen during the game or benchmark recording process, it is recommended that Fraps be run FIRST and Overlay second.

Typically, games can be run with both with no issues when Windows 7 is used, but users have experienced issues with Fraps and Overlay running concurrently with Windows 8.
CAPTURING GAME PLAYBACK & BENCHMARKS

Use VirtualDub

VirtualDub is an open-source video capture application that is licensed under the GNU General Public License (GPL).

http://virtualdub.sourceforge.net/

Configuring VirtualDub

We recommend completely configuring VirtualDub, and then saving your settings processing settings to a vdscript file. Once saved, you can easily load your processing settings by hitting Ctrl+L.

General Settings

Step 1: Under the Audio menu, make sure No audio is selected.

Step 2: Under the Options menu, select Performance. We recommend increasing the AVI Output buffering setting to match your memory setting. Reduce both wave input buffering and audio buffering sliders to the lowest setting (far left).
Capture AVI Settings

VirtualDub will move into a different window/mode once Capture AVI is selected. There are a number of settings located in the Capture AVI mode window.

**Step 3:** Next, go to the File menu and select Capture AVI. This will put VirtualDub into a new window and will enable capturing mode.

**Step 4:** Under the Device menu, select the Datapath VisionDVI-DL Video 01 (DirectShow) device. Once this is selected, you should see the desktop from the gaming system show up inside the VirtualDub window.

**Step 5:** Under the Capture menu, select Disk I/O, and change Chunk size to 8MB, and Chunks in buffer to 140. Make sure Windows write buffering is disabled.

**Step 6:** Under the Capture menu, select Settings and set Frame rate to 60.0.
Step 7: Under the Capture menu, select Timing. Make sure Drop frames and Insert null frames under the General options at the top of the Timing Options are CHECKED. Enabling these options will allow you to see when frames are being dropped during the capture.

Resolution Settings

Make sure the resolution settings in VirtualDub are correctly set to set the resolution of the gaming system. This is very important.

Step 8: Under the Video menu, select Capture Pin to open up the Pin Properties. Make sure the Default size is correctly set, or at least ensure the Custom Size is set to the resolution of the game display.

Step 9: Under the Video menu, select Set Custom Format. Ensure the custom size properly matches the gaming system resolution you will be capturing.

Step 10: Lastly, check the framerate (FPS) for the capture in the bottom-right corner of the Capture AVI window. Select the FPS number and a window will pop up. Make sure Integral 60.00 fps is correctly set.
Capturing Video

Once all of the settings above are done, you are ready to capture video.

Follow the steps below to begin the capture process.

**Step 1:** Turn off the overlay (and we mean the overlay in VirtualDub, not the overlay tool that generates color bars) before you begin a capture. The preview uses additional capture resource that will comprise the data rate of the capture.

**Step 2:** Under the File menu, select Set capture file to name your captured video. Make sure to place it on your SSD RAID array or other high-speed capture hardware.

**Step 3:** F7 starts a test capture, which means the capture is NOT saving any data to the drive(s). If you see no issues with a test capture by viewing a statistics window on the right side of screen and see that there are no dropped frames or no inserted frames, then try a real capture by pressing F5. If you see problems on real captures, but not in test captures, then it is likely that the datarate is higher than your drive(s) can support.
Step 4: Once you are capturing, look to the real-time data information displayed on the right side of the Capture AVI window.

NOTE: Make sure that the Overlay software that generates color bars is running on the game system BEFORE launching a game and capturing the video.
Before video capture begins

<table>
<thead>
<tr>
<th>Frames captured</th>
<th>Total time</th>
<th>Time left</th>
<th>Total file size</th>
<th>Disk space free</th>
<th>CPU usage</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>751</td>
<td>0.12</td>
<td>17.05</td>
<td>2966.3MB</td>
<td>44%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Video usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
</tr>
<tr>
<td>Average rate</td>
</tr>
<tr>
<td>Data rate</td>
</tr>
<tr>
<td>Compression ratio</td>
</tr>
<tr>
<td>Avg frame size</td>
</tr>
<tr>
<td>Frames dropped</td>
</tr>
<tr>
<td>Frames inserted</td>
</tr>
<tr>
<td>Resample</td>
</tr>
</tbody>
</table>

Video is capturing without dropped/inserted frames.

<table>
<thead>
<tr>
<th>Frames captured</th>
<th>Total time</th>
<th>Time left</th>
<th>Total file size</th>
<th>Disk space free</th>
<th>CPU usage</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2438</td>
<td>0.43</td>
<td>17.34</td>
<td>9.41GB</td>
<td>66%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Video usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
</tr>
<tr>
<td>Average rate</td>
</tr>
<tr>
<td>Data rate</td>
</tr>
<tr>
<td>Compression ratio</td>
</tr>
<tr>
<td>Avg frame size</td>
</tr>
<tr>
<td>Frames dropped</td>
</tr>
<tr>
<td>Frames inserted</td>
</tr>
<tr>
<td>Resample</td>
</tr>
</tbody>
</table>

Both dropped and inserted frames are shown above.

**Step 5:** If you see any inserted or dropped frames, then the capture is most likely bad as the data will include information that is not inherent in the game experience. Make sure you are capturing to an SSD RAID array or other high-speed storage device to try to overcome these issues, or try capturing at a lower resolution if still getting dropped or inserted frames.

**Video Playback & Testing**

It’s always a good idea to open your captured game video in VirtualDub to look for dropped and inserted frames.

**STEP 1:** You will need to Exit Capture Mode first. Do this under the File menu.

**STEP 2:** Once back in the main screen, select Open video file, and browse to the captured video.
STEP 3: Once open, you can step through the video using the controls at the bottom-left.

STEP 4: If you look closely at the bottom right of the tools, you will see this: [K]. This denotes a Key Frame. This is what you want. Dropped frames will have [D], and they will invalidate your capture.

STEP 5: Under the Go menu, you can quickly find dropped frames by selecting Next drop frame.
Extractor Analysis Tool

The Extractor tool will play back the video, analyzing the overlay colors to determine how the game frames were delivered to the screen during the capture. That data will be saved into an Excel file (.XLS), and can then be used with the FCAT scripts to generate the stats and charts.

Figure 14: The Extractor tool.

Figure 15: Extractor settings.
There are three settings in the Extractor application.

**Load Video File**
Click this button to browse to the video file that was created. One this is selected, click OK and the video will be played.

When processing is complete, a dialog box will pop up. Enter a filename for the data that was generated and save it to the hard drive.

**TROUBLESHOOTING:** If for some reason you get an error when you try to open a video, make sure that the video is good. Open the video inside VirtualDub and make sure it can play. Also, make sure the video was recorded with the Overlay enabled.

**Postprocessing**
Use the No postprocessing option. We will be using PERL scripts to post-process the data that is generated.

**Column to Analyze**
Use this to adjust the width of the columns being measured. This can be used when capturing Surround displays where the Field of View makes the color overlay skewed (wider).


The FCAT scripts are written with PERL. As such, a few applications including Strawberry Perl and GNU Plot are needed.

**Strawberry Perl and GNU Plot**

Using Perl and the software that’s required for the scripts

Install strawberry perl “http://strawberryperl.com/”
Install gnuplot “http://sourceforge.net/projects/gnuplot/files/”

![Strawberry Perl Setup](image)

**Figure 16:** Strawberry Perl

**Using the FCAT Scripts**

- **run_doall.bat, run_nv.bat, run_amd.bat**
  These are batch files that expedite the use of the PERL script files below.

- **fcat.pl**
  PERL script that combines bars and identifies runts and drops
  Output = CSV of HW frametimes (similar to Fraps), and CSV of Original FPS, New FPS, Runts, drops

- **gen_percentiles.pl**
  PERL script that generates the 95 and 99th frametime percentile calculations.

- **pivot.pl**
  PERL script that generates a summary CSV file (good for a pivot table).

- **doall.pl**
  PERL helper script to generate a big batch file.
STEP 1 | Unpack the FCAT Tools
The FCAT Tools will be delivered in a ZIP file. Uncompress this ZIP file to your C:\ drive, creating the directory C:\FCAT.

STEP 2 | FCAT Directory Structure
The C:\FCAT directory should contain three subdirectories: Analysis, Extractor, and Overlay. This structure is important because it will be called by batch files (run_doall.bat) for the scripts.

STEP 3 | Captures
We suggest making a Captures folder, with a Data subdirectory, then directories for GPUs, and then games.

Figure 17: Make your FCAT Tools directory structure look like this.

STEP 4 | run_doall.bat
Edit the run_doall.bat file located in the C:\FCAT\Analysis directory. It will look something like this:

Figure 18: Additional parameters including --gpu, --game, and --opt will be discussed later in this section.

Make sure the --tooldir parameter points to the FCAT directory and the --indir parameter points to the Captures directory on your RAID array. The --outdir directory is NV in the example above, which

Figure 20: Make a Captures folder on the high-speed array/drive(s). Save your captures there using the directory structure above.
means an NV folder will be created here when run:
C:\FCAT\Analysis\NV
The --outdir directory is where the charts and analysis data will be created.

Customizing the Data

The run_doall.bat file can be customized by using different parameters.

![Code Snippet]

**Figure 19:** Parameters including --gpu, --game, and --opt can also be used.

**Table 1: Parameters for the run_doall.bat file.**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--gpu</td>
<td>This parameter allows you to ONLY analyze data for a given GPU. Include these lines for all of your GPUs, or remove them to analyze data for all GPUs. Make sure that your GPU directory names match the names used here.</td>
</tr>
<tr>
<td>--game</td>
<td>This parameter allows you to ONLY analyze data for a given game. Make sure that your game directory names match the names used here.</td>
</tr>
<tr>
<td>--opt</td>
<td>The &quot;--fps 0&quot; will generate Frame Time information for the Percentile chart. The &quot;--fps 1&quot; will generate FPS information for the Percentile chart.</td>
</tr>
</tbody>
</table>
STEP 4 | Run the run_doall.bat files

Figure 21: Run the run_doall.bat file from a DOS prompt.

Figure 22: This is what the output of the run_doall.bat file looks like. It creates the run_fcat.bat file.
**STEP 5 | Run the run_fcat.bat file.**

**Figure 23:** The run_fcat.bat files is located in the C:\FCAT\Analysis\NV directory.

**Figure 24:** If you edit the run_fcat.bat file, you will see that it contains a bunch of DOS-based commands for analyzing and creating the final data.

**Figure 25:** Next, run the run_fcat.bat batch file.
Using the FCAT Data

Once the batch files have been run, the data can be analyzed.

Figure 26: Output from the run_fcat.bat file when it is run.

Figure 27: This is what the directory structure looks like after the batch files are run.
Figure 28: Two important charts are created in each of the game directories. They contain data for all of the graphics cards that were included in the D:\Captures\Data directory.

Figure 29: The PLOT.png file contains the frametime data.
Figure 30: The PER.png file contains the percentage data.

Figure 31: Inside each of the game folders, a bunch of additional data is created.
Figure 32: This is what the run.stats.png file looks like inside each individual GPU folder.

The two most important lines in the chart are the Fraps line and the FPS line. The Fraps line is the performance overall measured performance if all frames being delivered are treated as fully formed, evenly spaced, and equally displayed. The FPS blue line is the computed performance after dropped frames and runted frames are taken into account.

Dropped frames are any frame that is sent from a game to the graphics pipeline, is counted by Fraps, but for any reason is NOT displayed on the users display.
Figure 33: When charted, the Runt frame is shown in orange.

Runt frames are any frame that is sent from a game to the graphics pipeline, counted by Fraps, but for any reason is shown on the screen for an extremely short period of time – So short that the viewer effectively can’t see it.

The PIVOT Table

Also created is a PIVOT.csv file. This file can be used to generate a bar chart that shows the data from all included games. Pivot tables make using large amounts of data easier.

Figure 34: The PIVOT.csv file is located in the C:\FCAT\Analysis\NV folder.
Figure 35: Open the PIVOT.csv file, select the upper-left GAME cell, and hit Ctrl+A to select all of the data.

Figure 36: Once the data is selected, go to the Insert menu, and select PivotTable.
Figure 37: Click OK.

Figure 38: Select the GAME, GPU, OFPS, and NFPS fields to the right.
Figure 39: Select the **Row Labels** cell, hit Ctrl+A to select the data, and then go to the **Insert** menu and select **Column** charts.

Figure 40: You now have a fully configurable Pivot chart based on all of your game data.
Figure 41: You can also select 95Per and 99Per to chart the 95th percentile and 99th percentile data.
NVIDIA CONTACT INFORMATION

NVIDIA North/Latin America Public Relations

<table>
<thead>
<tr>
<th>Name</th>
<th>Title</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sean Cleveland</td>
<td>Senior Technical Marketing Manager</td>
<td>Office: 408 562 7555</td>
</tr>
<tr>
<td></td>
<td>SLI / Games / Surround</td>
<td>Lab Phone: 408 486 4115</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cell: 831 402 0145</td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="mailto:scleveland@nvidia.com">scleveland@nvidia.com</a></td>
</tr>
<tr>
<td>Tom “TAP” Petersen</td>
<td>Director of Marketing</td>
<td>Office: 408 486-2416</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cell: 415-722-3776</td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="mailto:tpetersen@nvidia.com">tpetersen@nvidia.com</a></td>
</tr>
<tr>
<td>Bryan &quot;BDR&quot; Del Rizzo</td>
<td>Senior PR Manager</td>
<td>Office: 408 486 2772</td>
</tr>
<tr>
<td></td>
<td>GeForce / 3D Vision / Surround</td>
<td>Cell: 510 331 8824</td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="mailto:bdelrizzo@nvidia.com">bdelrizzo@nvidia.com</a></td>
</tr>
<tr>
<td>Brandon Bell</td>
<td>Senior Technical Marketing Manager – Desktop GeForce GPUs</td>
<td>Office: 512 401 4589</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cell: 512 363 6698</td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="mailto:branbell@nvidia.com">branbell@nvidia.com</a></td>
</tr>
<tr>
<td>Nick Stam</td>
<td>Director, Technical Marketing</td>
<td>Office: 215 504 0321</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cell: 215 514 0400</td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="mailto:nstam@nvidia.com">nstam@nvidia.com</a></td>
</tr>
<tr>
<td>Solange Consens</td>
<td>Corp. Comms &amp; Product PR, Latin America</td>
<td>Office: +54 911 6629 0309</td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="mailto:sconsens@nvidia.com">sconsens@nvidia.com</a></td>
</tr>
<tr>
<td>Leo De Biase</td>
<td>Corp. Comms &amp; Product PR, Brazil</td>
<td>Office: +55 11 5501 2037</td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="mailto:ldebiase@nvidia.com">ldebiase@nvidia.com</a></td>
</tr>
</tbody>
</table>
# NVIDIA Europe Public Relations

## Lars Weinand
Senior Technical Marketing Manager, Europe  
Office: +49 89 6283 50013  
Cell: +49 173 7311540  
lwineinand@nvidia.com  
NVIDIA GmbH - Rosenheimerstr.145b  
81671 München  
EMEA

## Luciano Alibrandi
Director of Public Relations EMEAI  
Office: 33.1.55.63.84.92  
Cell: 33.6.07.40.54.98  
lalibrandi@nvidia.com  
Le Colisée - Bâtiment B - 6ème étage  
12, avenue de l’Arche - 92 400 Courbevoie  
FRANCE

## Susanna Tatár
PR Manager Central Europe  
Office: +49 89 6283 50029  
Cell: +49 162 2075110  
statar@nvidia.com  
NVIDIA GmbH  
Rosenheimerstr.145f-g  
81671 München  
GERMANY

## Jen Andersson
PR Manager Northern Europe  
1310 Arlington Business Park, 2/F  
jandersson@nvidia.com  
Theale, RG7 4SA, UK  
Mobile: +44 (0)7799 483 329  
Office: +44 (0)118 903 3047

## Stephane Quentin
Product PR Manager, France and Belgium  
Office: +33 155 638 493  
Cell: +33 614 308 655  
squentin@nvidia.com  
NVIDIA FRANCE  
Le Colisée - Bâtiment B - 6ème étage  
12, avenue de l’Arche – 92 400 Courbevoie  
FRANCE

## Benjamin Berraondo
Senior EMEAI PR Manager - GeForce  
Office: +44 118 903 3078  
Cell: +44 7979 384482  
bberraondo@nvidia.com  
NVIDIA Ltd  
1310 Arlington Business Park  
Theale, Berkshire RG7 4SA  
UNITED KINGDOM

## David Koblizek
Product PR Manager Central Eastern Europe  
Cell: +420 777 099 375  
dkoblizek@nvidia.com  
NVIDIA  
Videnska 63  
639 00 Brno  
Czech Republic

## Sebastien Januario
Product Public Relations  
Portugal / Spain  
Office: +33 (0) 1 55 63 16 51  
Cell: +336 73 98 73 23  
sjanuario@nvidia.com  
NVIDIA FRANCE  
Le Colisée - Bâtiment B - 6ème étage  
12, avenue de l’Arche – 92 400 Courbevoie  
FRANCE
Denis Kozlov
Technical Marketing Manager, Russia / CIS
Office: +7 495 981 0300 extra 10738
Cell: +7 916 196 6495
dekozlov@nvidia.com

Irina Shekhovtsova
PR Manager, Russia & CIS
Office: +7 495 981 03 00
Cell: +7 916 161 97 10
irinas@nvidia.com
NVIDIA Ltd
Arbat, 10, 7th floor
119002 Moscow
RUSSIA

Luciano Ballerano
PR Manager- Italy, Greece & Israel
Office: +39 0200618577
lballerano@nvidia.com
# NVIDIA Asia/Pacific Public Relations

<table>
<thead>
<tr>
<th>Name</th>
<th>Position</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Jeff Yen</strong></td>
<td>Senior Technical Marketing Manager, APAC</td>
<td><a href="mailto:jyen@nvidia.com">jyen@nvidia.com</a></td>
</tr>
<tr>
<td></td>
<td>Office: +886 987 263 193</td>
<td>NVIDIA</td>
</tr>
<tr>
<td></td>
<td>8, Kee Hu Road, Neihu</td>
<td>Taipei 114 TAIWAN</td>
</tr>
<tr>
<td><strong>Melody Tu</strong></td>
<td>Senior PR / Marketing Manager, APAC</td>
<td><a href="mailto:metu@nvidia.com">metu@nvidia.com</a></td>
</tr>
<tr>
<td></td>
<td>Office: +886 2 6605 5856</td>
<td>NVIDIA TASA (TW/AU/SEA)</td>
</tr>
<tr>
<td></td>
<td>8, Kee Hu Road, Neihu</td>
<td>Taipei 114 TAIWAN</td>
</tr>
<tr>
<td><strong>Kyle Kim</strong></td>
<td>Technical Marketing Manager, Korea</td>
<td><a href="mailto:kylek@nvidia.com">kylek@nvidia.com</a></td>
</tr>
<tr>
<td></td>
<td>Office: +82 2 6001 7186</td>
<td>NVIDIA Korea</td>
</tr>
<tr>
<td></td>
<td>#2101, COEX Trade Tower, 159-1</td>
<td>Samsung-dong Kangnam-gu, Seoul 135-729</td>
</tr>
<tr>
<td></td>
<td>KOREA</td>
<td></td>
</tr>
<tr>
<td><strong>Sunny Lee</strong></td>
<td>Marketing Manager, Korea</td>
<td><a href="mailto:slee@nvidia.com">slee@nvidia.com</a></td>
</tr>
<tr>
<td></td>
<td>Office: +82 2 6001 7123</td>
<td>NVIDIA Korea</td>
</tr>
<tr>
<td></td>
<td>#2101, COEX Trade Tower, 159-1</td>
<td>Samsung-dong Kangnam-gu, Seoul 135-729</td>
</tr>
<tr>
<td></td>
<td>KOREA</td>
<td></td>
</tr>
<tr>
<td><strong>Searching Shi</strong></td>
<td>Technical Marketing Manager, China</td>
<td><a href="mailto:sesshi@nvidia.com">sesshi@nvidia.com</a></td>
</tr>
<tr>
<td></td>
<td>Office: +86-10 5866 1500</td>
<td>NVIDIA Corp.</td>
</tr>
<tr>
<td></td>
<td>Unit 2901-2904, China World Tower 1</td>
<td>No.1 Jian Guo Men Wai Avenue</td>
</tr>
<tr>
<td></td>
<td>Beijing, P. R.</td>
<td>CHINA</td>
</tr>
<tr>
<td><strong>Steven Jin</strong></td>
<td>PR Manager, China</td>
<td><a href="mailto:jiyang@nvidia.com">jiyang@nvidia.com</a></td>
</tr>
<tr>
<td></td>
<td>Office: +86-10 5866 1500</td>
<td>NVIDIA Corp.</td>
</tr>
<tr>
<td></td>
<td>Unit 2901-2904, China World Tower 1</td>
<td>No.1 Jian Guo Men Wai Avenue</td>
</tr>
<tr>
<td></td>
<td>Beijing, P. R.</td>
<td>CHINA</td>
</tr>
<tr>
<td><strong>Kaori Nakamura</strong></td>
<td>PR/Marketing Manager, Japan</td>
<td><a href="mailto:knakamura@nvidia.com">knakamura@nvidia.com</a></td>
</tr>
<tr>
<td></td>
<td>Office: +81 3 6743 8712</td>
<td>ATT New Tower 13F</td>
</tr>
<tr>
<td></td>
<td>2-11-7 Akasaka, Minato-ku, Tokyo</td>
<td>Tokyo 107-0052 JAPAN</td>
</tr>
<tr>
<td><strong>Alex Chang</strong></td>
<td>Technical Marketing Analyst, TASA</td>
<td><a href="mailto:alechang@nvidia.com">alechang@nvidia.com</a></td>
</tr>
<tr>
<td></td>
<td>Office: +886 2 6605 5055</td>
<td>NVIDIA</td>
</tr>
<tr>
<td></td>
<td>8, Kee Hu Road, Neihu</td>
<td>Taipei 114 TAIWAN</td>
</tr>
</tbody>
</table>

---

**NVIDIA CONTACT INFORMATION**
NOTICE

ALL INFORMATION PROVIDED IN THIS WHITE PAPER, INCLUDING COMMENTARY, OPINION, NVIDIA DESIGN SPECIFICATIONS, REFERENCE BOARDS, FILES, DRAWINGS, DIAGNOSTICS, LISTS, AND OTHER DOCUMENTS (TOGETHER AND SEPARATELY, “MATERIALS”) ARE BEING PROVIDED “AS IS.” NVIDIA MAKES NO WARRANTIES, EXPRESSED, IMPLIED, STATUTORY, OR OTHERWISE WITH RESPECT TO MATERIALS, AND EXPRESSLY DISCLAIMS ALL IMPLIED WARRANTIES OF NONINFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE.

Information furnished is believed to be accurate and reliable. However, NVIDIA Corporation assumes no responsibility for the consequences of use of such information or for any infringement of patents or other rights of third parties that may result from its use. No license is granted by implication or otherwise under any patent or patent rights of NVIDIA Corporation. Specifications mentioned in this publication are subject to change without notice. This publication supersedes and replaces all information previously supplied. NVIDIA Corporation products are not authorized for use as critical components in life support devices or systems without express written approval of NVIDIA Corporation.

Trademarks

NVIDIA, the NVIDIA logo, and GeForce are trademarks or registered trademarks of NVIDIA Corporation in the United States and other countries. Other company and product names may be trademarks of the respective companies with which they are associated.

Copyright

© 2013 NVIDIA Corporation. All rights reserved.